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Home	Computer	Science	MCQs	of	MS	Word	Questions	and	Answers	MCQs	of	MS	Word	Questions	and	Answers	Papers	is	available	here.	Welcome	to	our	Microsoft	Word	Questions	and	Answers	Exam	papers	page.	Here	you	can	find	the	direct	link	for	various	Mcqs	on	MS	Office	Previous	Year	Question	Papers.	Find	the	latest	MS	Word	Practical
Questions	details	on	our	page.In	this	page,	we	have	given	the	direct	links	for	the	MS	Word	Exam	Questions	Papers.	Also,	Job	Seekers	who	are	looking	for	MS	Word	Question	Answer	Papers	can	find	here.The	Applicants	can	also	find	the	Quiz	on	Microsoft	Word	Exam	Syllabus	and	Test	Pattern	details	in	our	MS	Word	Practical	Exercise	Questions
Syllabus	page.	Where,	the	candidate	can	download	the	MS	Office	Question	Paper	pdf	for	free.However,	lets	check	the	MS	Word	Mcq	Questions	and	Answers	Exam	Question	Papers	details	below.	Are	you	eagerly	waiting	for	the	MCQs	of	MS	Word	Questions	and	Answers	Papers?	Dont	you	have	enough	money	to	buy	books	for	preparing	the	MS	Office
Objective	Questions	written	exam?We	have	attached	the	MCQs	of	MS	Word	Questions	and	Answers	Pdf.	So,	you	can	get	MCQs	of	MS	Word	Questions	and	Answers	PDf	at	free	of	cost.	Reading	the	MS	Word	Mcq	Questions	and	Answers	in	Hindi	Papers	not	only	helps	you	to	be	aware	of	the	previous	year	questions.	But	also,	you	can	sharpen	your
competitive	examination	for	MCQs	of	MS	Word	Skills.MS	Office	Objective	Questions	Previous	Papers	are	available	here	to	download.	Are	you	searching	for	MS	Word	Question	in	Hindi?	Aspirants	can	get	MS	Word	Question	Model	Papers	from	our	website.	Applicants	can	download	MS	Word	Questions	and	Answers	in	Hindi	Sample	Question	with
answers	in	our	website	for	free.We	have	provided	Microsoft	Word	Interview	Test,	MS	Word	Test	for	Interviews	Solved	Question	Papers	to	give	proper	guidance	for	the	aspirants	who	are	preparing	for	Theory	Questions	on	MS	Word	Exam.	These	MS	Word	Short	Questions	and	Answers	Practice	Question	Papers	are	helpful	for	the	candidates	during
exam	preparation.MS	Word	Questions	and	Answers	MCQs1.	Indention	in	word	processing	is	used	to(a)	make	the	text	readable(b)	change	the	paragraph	color(c)	apply	border	around	text(d)	change	line	spacing2.	In	MS	Word,	auto	Correct	was	originally	designed	to	replace	_________	words	as	you	type.(a)	short,	repetitive(b)	grammatically	incorrect(c)
misspelled(d)	none	of	the	above3.	In	word	processing,	Ctrl	+	PageDown	is	used	to(a)	Moves	the	cursor	one	Paragraph	Down(b)	Moves	the	cursor	one	Page	Down(c)	Moves	the	cursor	one	Line	Down(d)	Moves	the	cursor	one	Screen	Down4.	Which	file	starts	MS	Word?(a)	winword.exe(b)	word.exe(c)	msword.exe(d)	word2003.exe5.	By	default,	on	which
page	the	header	or	the	footer	is	printed	in	MS	Word?(a)	on	first	page(b)	on	alternate	page(c)	on	every	page(d)	none	of	the	above6.	In	MS	Word,	which	feature	helps	you	to	inserts	the	contents	of	the	Clipboard	as	text	without	any	formatting(a)	Paste	Special(b)	Format	Painter(c)	Page	Setup(d)	Styles7.	MS-Word	automatically	moves	the	text	to	the	next
line	when	it	reaches	the	right	edge	of	the	screen	and	is	called?(a)	Carriage	Return(b)	Enter(c)	Word	Wrap(d)	None	of	the	above8.	In	Word,	the	default	alignment	for	paragraphs	is	_________.(a)	left-aligned,	or	flush	margins	at	the	left	edge	and	uneven	edges	at	the	right	edge(b)	centered,	or	equidistant	from	both	the	left	edge	and	the	right	edge(c)	right-
aligned,	or	flush	margins	at	the	right	edge	and	uneven	edges	at	the	left	edge(d)	justified,	or	flush	margins	at	both	the	left	and	right	edges9.	The	minimum	number	of	rows	and	columns	in	MS	Word	document	is(a)	1	and	1(b)	2	and	1(c)	1	and	2(d)	2	and	210.	How	can	you	apply	exactly	the	same	formatting	you	did	to	another	text	in	MS	Word?(a)	Copy	the
text	and	paste	in	new	location.	Then	type	the	new	text	again.(b)	Copy	the	text	and	click	on	Paste	Special	tool	on	new	place(c)	Select	the	text	then	click	on	Format	Painter	and	select	the	new	text(d)	All	of	above11.	In	MS	Word,	small	squares,	called	_________,	on	the	selection	rectangle	that	surrounds	a	graphic	can	be	used	to	change	the	dimensions	of
the	graphic.(a)	scroll	boxes(b)	sizing	handles(c)	status	indicators(d)	move	handles12.	To	auto	fit	the	width	of	column	in	MS	Word(a)	Double	click	the	left	border	of	column(b)	Double	click	the	right	border	of	column(c)	Double	click	the	column	header(d)	All	of	above13.	How	can	you	apply	exactly	the	same	formatting	you	did	to	another	text	in	MS	Word?
(a)	Copy	the	text	and	click	on	Paste	Special	tool	on	new	place(b)	Select	the	text	then	click	on	Format	Painter	and	select	the	new	text(c)	Copy	the	text	and	paste	in	new	location.	Then	type	the	new	text	again(d)	All	of	these14.	In	MS	Word,	which	of	the	following	Tab	will	you	select	to	perform	addition	of	data	in	table	column?(a)	Home(b)	Insert(c)
Layout(d)	View15.	In	order	to	enable/disable	macros,	we	have	to	change	the	_________	in	MS	Word(a)	Trust	Center	settings(b)	Anti	Virus	settings(c)	View	settings(d)	References	settings16.	To	get	to	the	Symbol	dialog	box,	click	on	the	_________	menu	and	choose	Symbol.(a)	Tools(b)	Table(c)	Insert(d)	Format17.	What	is	gutter	margin?(a)	Margin	that	is
added	to	the	left	margin	when	printing(b)	Margin	that	is	added	to	right	margin	when	printing(c)	Margin	that	is	added	to	the	binding	side	of	page	when	printing(d)	Margin	that	is	added	to	the	outside	of	the	page	when	printing18.	In	MS	Word,	Ctrl	+	End	is	used	to(a)	Moves	the	cursor	to	the	end	of	Line(b)	Moves	the	cursor	to	the	end	of	Document(c)
Moves	the	cursor	to	the	end	of	Paragraph(d)	None	of	these19.	In	MS	Word,	the	default	alignment	for	paragraphs	is(a)	left-aligned,	or	flush	margins	at	the	left	edge	and	uneven	edges	at	the	right	edge(b)	centered,	or	equidistant	from	both	the	left	edge	and	the	right	edge(c)	right-aligned,	or	flush	margins	at	the	right	edge	and	uneven	edges	at	the	left
edge(d)	justified,	or	flush	margins	at	both	the	left	and	right	edges20.	Identify	from	the	following,	the	name	of	the	group	for	counting	the	number	of	lines	in	MS	Word.(a)	Page	Setup(b)	Tables(c)	Footnotes(d)	CaptionsMore	Question	Set	on	Basic	Computer	Knowledge	21.	To	auto	fit	the	width	of	column	in	MS	Word(a)	Double	click	the	left	border	of
column(b)	Double	click	the	right	border	of	column(c)	Double	click	the	column	header(d)	All	of	these22.	You	can	detect	spelling	and	grammar	errors	by(a)	Press	Shift	+	F7(b)	Press	Ctrl	+	F7(c)	Press	Alt+	F7(d)	Press	F723.	In	MS	Word,	the	key	F12	opens	a(a)	Save	As	dialog	box(b)	Open	dialog	box(c)	Save	dialog	box(d)	Close	dialog	box24.	Portrait	and
Landscape	are(a)	Page	Orientation(b)	Paper	Size(c)	Page	Layout(d)	All	of	above25.	Which	of	the	following	is	not	a	font	style?(a)	Bold(b)	Italics(c)	Regular(d)	Superscript26.	Which	of	the	following	is	not	essential	component	to	perform	a	mail	merge	operation	in	MS	Word?(a)	Main	document(b)	Data	source(c)	Merge	fields(d)	Word	fields27.	Small
squares,	called	__________,	on	the	selection	rectangle	that	surrounds	a	graphic	can	be	used	to	change	the	dimensions	of	the	graphic.(a)	scroll	boxes(b)	sizing	handles(c)	status	indicators(d)	move	handles28.	The	minimum	number	of	rows	and	columns	in	MS	Word	document	is(a)	1	and	1(b)	2	and	1(c)	1	and	2(d)	2	and	2Also	Read	about	MS-Excel29.	MS-
Word	automatically	moves	the	text	to	the	next	line	when	it	reaches	the	right	edge	of	the	screen,	this	is	called(a)	Carriage	Return(b)	Enter(c)	Word	Wrap(d)	None	of	these30.	Thesaurus	tool	in	MS	Word	is	used	for(a)	Deletion(b)	Synonyms	and	Antonyms	words(c)	Grammar	options(d)	All	of	above31.	AutoCorrect	was	originally	designed	to	replace
__________	words	as	you	type.(a)	Grammatically	incorrect(b)	Sentence	incorrect(c)	Misspelled(d)	None	of	these32.	The	Word	Count	command	on	the	Tools	menu	displays	the	number	of	words	as	well	as	the	number	of	__________	in	the	current	document.(a)	Lines(b)	Characters(c)	Paragraphs(d)	All	of	these33.	In	Microsoft	Word,	quick	print	will	print(a)
Only	the	first	page	of	the	document	once(b)	All	pages	of	the	document	once(c)	All	Odd	pages	of	the	document	once(d)	All	even	pages	of	the	document	once34.	What	is	the	Maximum	font	size	that	can	be	applied	to	any	character?(a)	16(b)	163(c)	1638(d)	1603835.	By	default,	Word	document	print	with(a)	1	inch	top	and	bottom	margin(b)	Landscape
orientation(c)	Page	number	at	lower	left	corner(d)	Font	size	1636.	What	is	the	largest	and	smallest	font	size	in	Microsoft	Word	formatting	tool	bar?(a)	8	and	82(b)	12	and	82(c)	12	and	72(d)	8	and	7237.	If	you	want	to	convert	a	symbol	or	several	lines	of	text	into	an	Auto	Correct	entry,	you	should(a)	Insert	the	symbol	or	type	the	text	in	word	document
first.	Then,	select	the	text	or	symbol	and	go	to	the	Auto	Correct	dialog	box.(b)	Click	the	tools	menu	and	choose	Auto	Correct	options.	Then,	Click	the	Insert	menu	and	choose	symbol	(or	Click	the	format	menu	and	choose	paragraph)	to	add	the	symbol	or	paragraph	to	Autocorrect.(c)	Auto	correct	can	only	accommodate	one	line	of	text.	It	is	not	possible
to	convert	a	symbol	or	multiple	lines	of	text	into	an	Auto	Correct	entry.(d)	Insert	the	symbol	or	type	the	text	in	a	word	document	first.	Then,	Select	the	text	or	symbol	and	click	the	edit	menu	followed	by	Paste	special.	Select	New	Auto	Correct	Entry	and	then	Click	OK.38.	A	__________	is	a	dot	or	other	symbol	positioned	at	the	beginning	of	the
paragraph(a)	Bullet(b)	Logo(c)	Cell(d)	Target39.	Ctrl+	A	is	a	shortcut	for(a)	Align	Right(b)	Select	All(c)	Change	Font(d)	Save	Document40.	When	inserting	page	number	in	footer	it	appeared	1	but	you	wish	to	show	a.	How	can	you	do	that?(a)	From	format	menus	choose	Bullets	and	Numbering	and	configure	necessary	setting(b)	From	insert	menu
choose	page	number	and	specify	necessary	setting(c)	Click	on	Page	number	format	tool	and	specify	required	setting(d)	From	preference	menu,	select	page	number	and	specify	necessary	setting41.	In	a	document,	what	is	the	maximum	number	of	columns	that	can	be	inserted	in	MS	Word	table?(a)	35(b)	45(c)	63(d)	6542.	When	same	word	is	used	in
multiple	locations	or	a	word	is	used	that	was	not	quite	appropriate,	a	thesaurus	can	be	used	to	look	up	a(n)	__________	or	a	word	in	similar	meaning(a)	Synonym(b)	Homonym(c)	Antonym(d)	Metronym43.	Which	of	the	following	is	not	essential	component	to	perform	a	mail	merge	operation?(a)	Main	document(b)	Data	source(c)	Merge	fields(d)	Word
fields44.	Which	way	is	to	be	followed	to	insert	picture	in	Word	document?(a)	Click	Home	in	menu	bar,	then	setting,	and	select	Insert	Picture(b)	Click	picture	in	menu	bar,	then	click	insert(c)	Click	insert	in	menu	bar,	then	click	insert(d)	Right	Click	on	the	place	you	want,	and	then	click	Insert	Picture45.	The	default	extension	for	MS-Word	document	is(a)
.doc	or	.docx(b)	.doc	or	.txt(c)	.docx	or	.txt(d)	.file	or	.txt46.	Shortcut	key	to	save	MS-Word	document	is(a)	Alt+s(b)	Ctrl+s(c)	Alt+Ctrl+s(d)	Shift+Ctrl+s47.	The	Key	to	bring	cursor	in	the	beginning	of	the	current	line	in	MS-Word	is(a)	Page	Up(b)	Page	Down(c)	Home(d)	EndClick	to	Read	about	MS-PowerPoint48.	How	many	types	of	alignment	of	text
are	there	in	MS-Word?(a)	2(b)	3(c)	4(d)	549.	One	of	the	features	of	Ms-Word	to	correct	common	spelling	mistakes	is_____(a)	Auto	Correct(b)	Auto	Spelling(c)	Auto	Check(d)	Auto	Verify50.	The	ability	to	combine	name	and	addresses	with	a	standard	document	is	called	_________(a)	Document	formatting(b)	Database	management(c)	Mail	Merge(d)	Format
letters51.	Which	can	be	used	for	quick	access	to	commonly	used	commands	and	tools?(a)	Status	bar(b)	Tool	bar(c)	Menu	bar(d)	Title	bar52.	Ctrl	+	Right	Arrow	is	used	to(a)	Moves	the	cursor	one	word	right(b)	Moves	the	cursor	end	of	the	line(c)	Moves	the	cursor	end	of	the	document(d)	Moves	the	cursor	one	Paragraph	down53.	Ctrl	+	G	is	used	to(a)
Open	Paragraph	Dialog	box	activating	Goto	Tab(b)	Open	Page	Setup	Dialog	box	activating	Goto	Tab(c)	Open	Find	and	Replace	Dialog	box	with	activating	Goto	Tab(d)	Open	Goto	Dialog	box54.	Which	view	can	be	used	to	see	how	text	and	graphics	will	appear	on	the	printed	page?(a)	Normal(b)	Print	preview(c)	Outline(d)	Web	Layout55.	How	can	you
apply	exactly	the	same	formatting	you	did	to	another	text?(a)	Copy	the	text	and	paste	in	new	location.	Then	type	the	new	text	again(b)	Copy	the	text	and	click	on	Paste	Special	tool	on	new	place(c)	Select	the	text	then	click	on	Format	Painter	and	select	the	new	text(d)	All	of	these56.	The	maximum	number	of	columns	that	can	be	inserted	in	MS-Word
table	is(a)	35(b)	15(c)	63(d)	6557.	What	is	the	use	of	bookmarks	in	Microsoft	Word?(a)	To	easily	correct	the	spelling	errors(b)	To	quickly	jump	to	the	ending	of	the	document(c)	To	quickly	jump	to	a	specific	location	in	the	document(d)	To	create	a	link	within	the	document58.	What	is	the	shortcut-key	for	manual	line	break?(a)	CTRL	+	Enter(b)	Alt	+
Enter(c)	Space	+	Enter(d)	Shift	+	Enter59.	Which	of	the	following	do	you	use	to	change	margins?(a)	formatting	toolbar(b)	page	setup	dialog	box(c)	Standard	toolbar(d)	paragraph	dialog	box60.	Which	of	the	following	operations	moves	text	from	clipboard?(a)	Copy(b)	Paste(c)	Drag	and	Drop(d)	Cut61.	Which	of	the	following	can	be	used	to	divide	a	web
page	into	areas?(a)	Frames(b)	theme(c)	table	of	contents(d)	none	of	the	above62.	The	ability	to	combine	name	and	addresses	with	a	standard	document	is	called	.(a)	document	formatting(b)	database	management(c)	mail	merge(d)	form	letters63.	Which	would	you	choose	to	save	a	document	with	a	new	name?(a)	Press	Ctrl+S(b)	Click	File,	Save(c)	Click
Tools,	Options,	Save(d)	Click	File,	Save	As64.	Which	of	the	following	moves	the	insertion	point	to	the	previous	cell	of	the	table	in	MS-Word?(a)	[Tab](b)	[Shift]+[Tab](c)	[Alt]+[Tab](d)	[Ctrl]+[Tab]65.	How	to	use	Format	Painter	multiple	times(a)	By	Click	on	Lock	Format	Painter	Icon(b)	By	Double	Click	on	the	Format	Painter	Icon(c)	By	Selecting	Edit	->
Format	Painter	->	Multiple	Use(d)	Format	Painter	cannot	be	use	multiple	times66.	Gutter	position	can	be	set	in	following	positions(a)	Left	&	Right(b)	Left	&	Top(c)	Left	&	Bottom(d)	Left	Only67.	AutoCorrect	was	originally	designed	to	replace	_________	words	as	you	type.(a)	Short,	repetitive(b)	Grammatically	incorrect(c)	Misspelled(d)	None	of	the
above68.	Where	can	you	find	the	Draw	Table	tool	button?(a)	Standard	toolbar(b)	Formatting	toolbar(c)	Drawing	toolbar(d)	Tables	and	Formatting	toolbar	Share	with	your	Friends.	This	page	contains	MS	Word	MCQs	practice	test	questions	that	are	asked	in	almost	every	job	test	or	exam.	We	have	compiled	the	most	important	and	most	repeated
questions	from	past	papers	and	exams.Our	test	system	will	also	help	you	to	check	your	knowledge	(GK)	about	computer	application	software	Microsoft	MS	Office	Word.	We	have	covered	complete	MS	Microsoft	Word	2007,	MS	word	2010,	Microsoft	word	2016	shortcuts	keys	a	to	z.Instructions	for	taking	the	online	test:Click	the	desired	link	to	open	a
quizEach	MCQ	carries	one	markEach	question	contains	4	MCQ,	you	can	click	the	right	optionIf	you	want	to	see	the	answer	of	an	MCQ	you	can	click	on	See	Answer	ButtonAt	the	end	of	a	quiz	click	on	submit	button	to	get	your	test	resultClick	on	try	again	button	to	re-take	the	quiz	Home	Terms	&	Conditions	Contact	Microsoft	word	is	a	part	of	MS	office
package,	In	today	scenario,	basic	knowledge	of	ms	word	is	necessary	for	all	the	candidates.	Students	preparing	for	SSC,	Bank	PO	and	other	competitive	exams	can	practice	to	enhance	their	performance	with	these	selective	and	important	MS	Word	questions	and	answers.	Here	are	some	important	MS	Word	questions,	which	are	repeated	in
examinations	every	year.	Q	1.	Which	toolbar	has	a	crop	button	option	?	Ans.	Picture	toolbar	Q	2.	What	must	be	used	to	control	the	layering	of	objects	?	Ans.	Drawing	toolbar	Q	3.	Which	command	enables	you	to	make	multiple	changes	in	a	document	at	once	?	Ans.	Replace	command	Q	4.	Ctrl	+	backspace	key	is	used	for	?	Ans.	Delete	the	word	just
before	the	cursor.	Q	5.	Ctrl	+	Delete	key	is	used	to	?	Ans.	Delete	the	word	just	after	the	cursor.	Q	6.	How	to	remove	all	character	formats	?	Ans.	Ctrl	+	Spacebar	Q	7.	What	is	the	shortcut	key	to	insert	Hyperlink	in	a	document	?	Ans.	Ctrl	+	K	Q	8.	Which	feature	do	you	use	to	create	a	newspaper	like	document	?	Ans.	Columns	Q	9.	What	Ctrl	+	E	do	in
document	?	Ans.	Align	center	Q	10.	A	master	document	contains	_______	,	each	of	which	contains	a	pointer	to	a	file	on	a	disk	?	Ans.	Sub	documents	Q	11.	When	you	click	on	File	menu	in	MS	word	2010,	it	opens	?	Ans.	Backstage	view	Q	12.	Which	shortcut	key	is	used	to	increase	the	page	left	indent	?	Ans.	Ctrl	+	M	Q	13.	The	word	rap	feature	do	?	Ans.
Automatically	move	text	to	the	next	line	when	neccessary.	Q	14.	What	is	Spike	in	MS	word	?	Ans.	It	allow	you	to	combine	text	from	several	documents	and	then	insert	all	the	text	into	one	document	at	one	time.	Q	15.	The	_________	in	the	resume	wizard	dialog	box	indicates	the	wizard	is	ready	to	create	the	document.	Ans.	Finish	panel	Q	16.	What	is
document	outline	view	?	Ans.	A	view	with	a	structure	of	heading	at	various	levels.	Q	17.	What	do	you	call	collection	of	characters	and	paragraph	formatting	commands	?	Ans.	A	style	Q	18.	How	will	MS	Word	will	respond	in	repeated	word	?	Ans.	A	red	wavy	line	shows	under	the	repeated	word.	Q	19.	By	default,	your	document	prints	with	?	Ans.	1	inch
top	and	bottom	marginsA	portrait	orientation1.25	inches	left	and	right	margin	Q	20.	How	many	different	positions	can	you	set	for	Drop	cap	?	Ans.	2	Q	21.	A	screen	element	of	MS	word	that	is	usually	located	below	the	title	bar	that	provided	categorized	options	is	called	?	Ans.	Menu	bar	Q	22.	Changing	the	apperance	of	a	document	is	called	?	Ans.
Formatting	Q	23.	From	where,	you	can	hide	some	paragraph	in	a	document	?	Ans.	From	Font	dialog	box	Q	24.	Which	position	is	not	available	for	fonts	on	MS	Word	?	Ans.	Centered	Q	25.	The	feature	of	word	that	automatically	adjust	the	amount	of	space	between	certain	combination	of	characters	so	that	an	entire	word	looks	more	evently	spaced.	What
that	feature	called	?	Ans.	Kerning	Q	26.	Shimmer,	Sparkle	text,	Blinking	background	etc.	are	known	as	?	Ans.	Font	effects	Q	27.	Where	you	can	find	the	Draw	table	tool	button	?	Ans.	Tables	and	formatting	toolbar	Q	28.	How	can	you	remove	tab	stop	marker	from	the	ruler	?	Ans.	Drag	the	tab	stop	marker	out	of	the	ruler.	Q	29.	Which	indent	marker
controls	all	the	lines	except	first	line	?	Ans.	Left	indent	marker	Q	30.	What	you	should	do	if	you	require	pasting	the	same	format	in	many	places	?	Ans.	Double	click	the	format	painter	then	go	on	pasting	in	many	places.	Skip	to	content	Home>Career>Top	100+	MS	Word	Questions	Answers	For	Exam	&	Job	Interviews	Microsoft	Word	is	a	popular	word-
processing	software	used	for	creating,	editing,	formatting,	and	sharing	documents.	Understanding	how	to	use	Microsoft	Word	effectively	is	crucial	for	many	job	roles	and	academic	purposes.	Multiple-choice	questions	(MCQs)	are	a	great	way	to	test	your	knowledge	of	Microsoft	Word.	This	article	provides	a	collection	of	100	MS	Word	Questions	And
Answers	to	help	you	learn	and	prepare	for	exams	or	job	interviews.1.	What	is	Microsoft	Word?A)	A	spreadsheet	programB)	A	word	processing	programC)	A	presentation	programD)	An	email	clientAnswer:	B)	A	word	processing	program2.	Which	shortcut	key	is	used	to	save	a	document	in	Microsoft	Word?A)	Ctrl	+	SB)	Ctrl	+	PC)	Ctrl	+	CD)	Ctrl	+
XAnswer:	A)	Ctrl	+	S3.	How	do	you	protect	a	Word	document	with	a	password?a)	File	->	Save	As	->	Tools	->	General	Optionsb)	Insert	->	Passwordc)	Home	->	Protect	Documentd)	Review	->	Protect	DocumentAnswer:	a)	File	->	Save	As	->	Tools	->	General	Options4.	What	is	the	default	file	extension	for	a	Word	document	in	Microsoft	Word	2016?A)
.xlsB)	.pptC)	.docxD)	.txtAnswer:	C)	.docx5.	Which	function	is	used	to	check	spelling	and	grammar	in	Microsoft	Word?A)	Review	>	ThesaurusB)	Review	>	Word	CountC)	Review	>	Spelling	&	GrammarD)	Review	>	Track	ChangesAnswer:	C)	Review	>	Spelling	&	Grammar6.	What	is	the	purpose	of	the	Home	tab	in	Microsoft	Word?A)	To	insert	picturesB)
To	apply	font	and	paragraph	formattingC)	To	create	tablesD)	To	set	page	layoutAnswer:	B)	To	apply	font	and	paragraph	formatting7.	How	do	you	select	all	text	in	a	document?A)	Ctrl	+	AB)	Ctrl	+	EC)	Ctrl	+	FD)	Ctrl	+	BAnswer:	A)	Ctrl	+	A8.	What	is	the	use	of	the	Insert	tab	in	Microsoft	Word?A)	To	format	textB)	To	check	spellingC)	To	insert	images,
tables,	and	shapesD)	To	save	a	documentAnswer:	C)	To	insert	images,	tables,	and	shapes9.	Which	shortcut	key	is	used	to	copy	selected	text	in	Microsoft	Word?A)	Ctrl	+	XB)	Ctrl	+	PC)	Ctrl	+	VD)	Ctrl	+	CAnswer:	D)	Ctrl	+	CRelated	Article	:	A	To	Z	Computer	Full	Form.10.	Which	shortcut	key	is	used	to	paste	copied	text	in	Microsoft	Word?A)	Ctrl	+
CB)	Ctrl	+	XC)	Ctrl	+	VD)	Ctrl	+	ZAnswer:	C)	Ctrl	+	V11.	What	does	Ctrl	+	Z	do	in	Microsoft	Word?A)	Redo	the	last	actionB)	Undo	the	last	actionC)	Save	the	documentD)	Open	a	new	documentAnswer:	B)	Undo	the	last	action12.	What	is	the	purpose	of	the	Page	Layout	tab	in	Microsoft	Word?A)	To	insert	imagesB)	To	set	page	margins,	orientation,	and
sizeC)	To	check	spellingD)	To	apply	paragraph	formattingAnswer:	B)	To	set	page	margins,	orientation,	and	size13.	Which	feature	in	Microsoft	Word	automatically	moves	text	to	the	next	line	when	it	reaches	the	end	of	the	page?A)	AutoCorrectB)	Word	WrapC)	AutoFormatD)	Spell	CheckAnswer:	B)	Word	Wrap14.	What	does	the	Undo	function	do	in
Microsoft	Word?a)	Saves	the	documentb)	Redoes	the	last	actionc)	Cancels	the	last	actiond)	Copies	the	textAnswer:	c)	Cancels	the	last	action15.	How	can	you	create	a	new	document	in	Microsoft	Word?a)	Ctrl	+	Nb)	Ctrl	+	Oc)	Ctrl	+	Sd)	Ctrl	+	PAnswer:	a)	Ctrl	+	N16.	How	can	you	increase	the	font	size	of	selected	text	in	Microsoft	Word?A)	Home	>
Font	Size	drop	downB)	Insert	>	Font	SizeC)	Review	>	Font	SizeD)	View	>	Font	SizeAnswer:	A)	Home	>	Font	Size	drop	down17.	Which	feature	in	Microsoft	Word	allows	you	to	see	how	the	printed	document	will	look?A)	Print	PreviewB)	Print	LayoutC)	Outline	ViewD)	Draft	ViewAnswer:	A)	Print	Preview18.	How	do	you	save	a	document	with	a	new
name	in	Microsoft	Word?A)	File	>	SaveB)	File	>	Save	AsC)	File	>	OpenD)	File	>	PrintAnswer:	B)	File	>	Save	As19.	What	is	the	function	of	the	Save	As	option	in	Microsoft	Word?a)	Saves	the	document	with	the	same	nameb)	Saves	the	document	with	a	different	name	or	formatc)	Saves	the	document	in	a	different	folderd)	Both	b	and	cAnswer:	d)	Both	b
and	c20.	How	do	you	insert	a	page	break	in	Microsoft	Word?A)	Insert	>	Page	BreakB)	Page	Layout	>	BreaksC)	Home	>	BreaksD)	View	>	BreaksAnswer:	A)	Insert	>	Page	Break21.	What	is	the	function	of	Ctrl	+	P	in	Microsoft	Word?A)	To	paste	textB)	To	print	a	documentC)	To	open	a	new	documentD)	To	save	a	documentAnswer:	B)	To	print	a
document22.	How	do	you	increase	the	font	size	of	the	selected	text	in	Microsoft	Word?a)	Ctrl	+	[b)	Ctrl	+	]c)	Ctrl	+	Shift	+	>d)	Ctrl	+	Shift	+	23.	What	is	the	use	of	the	Split	option	in	Microsoft	Word?a)	To	divide	the	document	into	two	partsb)	To	merge	two	documentsc)	To	split	text	into	columnsd)	To	check	the	word	countAnswer:	a)	To	divide	the
document	into	two	partsRelated	Article	:	Computer	Questions	&	Answers	-1.24.	How	do	you	underline	text	in	Microsoft	Word?A)	Ctrl	+	UB)	Ctrl	+	IC)	Ctrl	+	BD)	Ctrl	+	AAnswer:	A)	Ctrl	+	U25.	Which	key	combination	is	used	to	create	a	bullet	list	in	Microsoft	Word?A)	Ctrl	+	Shift	+	BB)	Ctrl	+	Shift	+	LC)	Ctrl	+	Shift	+	ND)	Ctrl	+	Shift	+	MAnswer:	B)
Ctrl	+	Shift	+	L26.	How	can	you	insert	a	symbol	in	a	Word	document?a)	Insert	->	Symbolb)	Home	->	Symbolc)	Layout	->	Symbold)	Review	->	SymbolAnswer:	a)	Insert	->	Symbol27.	How	can	you	convert	a	Word	document	into	a	PDF?a)	File	->	Save	As	->	PDFb)	Insert	->	PDFc)	Review	->	Convertd)	Home	->	ConvertAnswer:	a)	File	->	Save	As	->
PDF28.	How	can	you	add	a	hyperlink	in	Microsoft	Word?A)	Insert	>	HyperlinkB)	Home	>	HyperlinkC)	View	>	HyperlinkD)	Review	>	HyperlinkAnswer:	A)	Insert	>	Hyperlink29.	Which	feature	in	Microsoft	Word	allows	you	to	track	changes	made	to	a	document?A)	Track	ChangesB)	Word	CountC)	ThesaurusD)	Mail	MergeAnswer:	A)	Track	Changes30.
How	do	you	insert	a	comment	in	Microsoft	Word?a)	Insert	->	Commentb)	Layout	->	Commentc)	References	->	Insert	Commentd)	Review	->	New	CommentAnswer:	d)	Review	->	New	Comment31.	How	can	you	insert	a	table	in	Microsoft	Word?A)	Insert	>	TableB)	Home	>	TableC)	View	>	TableD)	Review	>	TableAnswer:	A)	Insert	>	Table32.	How	do
you	apply	a	header	to	a	document	in	Microsoft	Word?A)	Insert	>	HeaderB)	Home	>	HeaderC)	Page	Layout	>	HeaderD)	Review	>	HeaderAnswer:	A)	Insert	>	Header33.	How	can	you	add	page	numbers	to	a	document	in	Microsoft	Word?A)	Insert	>	Page	NumbersB)	Home	>	Page	NumbersC)	View	>	Page	NumbersD)	Review	>	Page	NumbersAnswer:
A)	Insert	>	Page	Numbers34.	What	is	the	purpose	of	the	View	tab	in	Microsoft	Word?A)	To	format	textB)	To	change	document	views	and	show/hide	rulers	and	gridlinesC)	To	insert	imagesD)	To	apply	stylesAnswer:	B)	To	change	document	views	and	show/hide	rulers	and	gridlines35.	How	can	you	create	a	footnote	in	Microsoft	Word?A)	References	>
Insert	FootnoteB)	Insert	>	FootnoteC)	Home	>	FootnoteD)	View	>	FootnoteAnswer:	A)	References	>	Insert	Footnote36.	What	is	the	function	of	Ctrl	+	X	in	Microsoft	Word?A)	Copy	textB)	Cut	textC)	Paste	textD)	Undo	actionAnswer:	B)	Cut	text37.	How	can	you	insert	a	watermark	in	a	document	in	Microsoft	Word?A)	Design	>	WatermarkB)	Insert	>
WatermarkC)	Home	>	WatermarkD)	Review	>	WatermarkAnswer:	A)	Design	>	Watermark38.	What	is	the	use	of	the	Design	tab	in	Microsoft	Word?A)	To	apply	document	themes,	styles,	and	colorsB)	To	check	spellingC)	To	insert	tablesD)	To	track	changesAnswer:	A)	To	apply	document	themes,	styles,	and	colors39.	How	do	you	align	text	to	the	center
in	Microsoft	Word?A)	Ctrl	+	EB)	Ctrl	+	LC)	Ctrl	+	RD)	Ctrl	+	JAnswer:	A)	Ctrl	+	E40.	How	do	you	align	text	to	the	left	in	Microsoft	Word?A)	Ctrl	+	EB)	Ctrl	+	LC)	Ctrl	+	RD)	Ctrl	+	JAnswer:	B)	Ctrl	+	L41.	How	do	you	align	text	to	the	right	in	Microsoft	Word?A)	Ctrl	+	EB)	Ctrl	+	LC)	Ctrl	+	RD)	Ctrl	+	JAnswer:	C)	Ctrl	+	R42.	How	do	you	justify	text	in
Microsoft	Word?A)	Ctrl	+	EB)	Ctrl	+	LC)	Ctrl	+	RD)	Ctrl	+	JAnswer:	D)	Ctrl	+	J43.	What	does	Ctrl	+	H	do	in	Microsoft	Word?A)	Open	the	Find	dialog	boxB)	Open	the	Replace	dialog	boxC)	Open	the	Save	As	dialog	boxD)	Open	the	Print	dialog	boxAnswer:	B)	Open	the	Replace	dialog	box44.	How	do	you	change	the	line	spacing	in	a	document	in	Microsoft
Word?A)	Home	>	Line	and	Paragraph	SpacingB)	Insert	>	Line	SpacingC)	View	>	Line	SpacingD)	Review	>	Line	SpacingAnswer:	A)	Home	>	Line	and	Paragraph	Spacing45.	How	can	you	add	a	border	to	a	page	in	Microsoft	Word?A)	Design	>	Page	BordersB)	Insert	>	Page	BordersC)	Home	>	Page	BordersD)	Review	>	Page	BordersAnswer:	A)	Design
>	Page	Borders46.	What	is	the	purpose	of	Ctrl	+	Shift	+	D	in	Microsoft	Word?A)	Double	underline	textB)	Delete	textC)	Save	the	documentD)	Close	the	documentAnswer:	A)	Double	underline	text47.	How	do	you	insert	a	symbol	in	Microsoft	Word?A)	Insert	>	SymbolB)	Home	>	SymbolC)	View	>	SymbolD)	Review	>	SymbolAnswer:	A)	Insert	>
Symbol48.	What	does	the	Word	Count	feature	in	Microsoft	Word	do?A)	Counts	the	number	of	words,	characters,	and	pages	in	the	documentB)	Formats	the	textC)	Tracks	changesD)	Saves	the	documentAnswer:	A)	Counts	the	number	of	words,	characters,	and	pages	in	the	document49.	How	do	you	insert	a	cover	page	in	Microsoft	Word?A)	Insert	>
Cover	PageB)	Home	>	Cover	PageC)	View	>	Cover	PageD)	Review	>	Cover	PageAnswer:	A)	Insert	>	Cover	Page50.	What	is	the	use	of	the	Thesaurus	feature	in	Microsoft	Word?A)	To	find	synonyms	and	antonyms	for	a	selected	wordB)	To	check	spellingC)	To	track	changesD)	To	create	a	tableAnswer:	A)	To	find	synonyms	and	antonyms	for	a	selected
word51.	How	can	you	convert	text	to	a	table	in	Microsoft	Word?A)	Insert	>	Table	>	Convert	Text	to	TableB)	Home	>	Table	>	Convert	Text	to	TableC)	View	>	Table	>	Convert	Text	to	TableD)	Review	>	Table	>	Convert	Text	to	TableAnswer:	A)	Insert	>	Table	>	Convert	Text	to	Table52.	What	is	the	function	of	Ctrl	+	Shift	+	F	in	Microsoft	Word?A)
Open	the	Font	dialog	boxB)	Save	the	documentC)	Print	the	documentD)	Open	the	Find	dialog	boxAnswer:	A)	Open	the	Font	dialog	box53.	How	do	you	create	a	drop	cap	in	Microsoft	Word?A)	Insert	>	Drop	CapB)	Home	>	Drop	CapC)	Page	Layout	>	Drop	CapD)	Review	>	Drop	CapAnswer:	A)	Insert	>	Drop	Cap54.	How	can	you	merge	cells	in	a	table	in
Microsoft	Word?A)	Select	cells	>	Layout	>	Merge	CellsB)	Select	cells	>	Insert	>	Merge	CellsC)	Select	cells	>	Home	>	Merge	CellsD)	Select	cells	>	View	>	Merge	CellsAnswer:	A)	Select	cells	>	Layout	>	Merge	Cells55.	What	is	the	function	of	Ctrl	+	Shift	+	G	in	Microsoft	Word?A)	Open	the	Word	Count	dialog	boxB)	Open	the	Font	dialog	boxC)	Save
the	documentD)	Print	the	documentAnswer:	A)	Open	the	Word	Count	dialog	box56.	How	do	you	add	a	comment	in	Microsoft	Word?A)	Review	>	New	CommentB)	Insert	>	New	CommentC)	Home	>	New	CommentD)	View	>	New	CommentAnswer:	A)	Review	>	New	Comment57.	What	is	the	purpose	of	the	Styles	feature	in	Microsoft	Word?A)	To	apply
consistent	formatting	to	textB)	To	insert	imagesC)	To	create	tablesD)	To	check	spellingAnswer:	A)	To	apply	consistent	formatting	to	text58.	How	can	you	protect	a	document	in	Microsoft	Word?A)	File	>	Info	>	Protect	DocumentB)	Insert	>	Protect	DocumentC)	Home	>	Protect	DocumentD)	Review	>	Protect	DocumentAnswer:	A)	File	>	Info	>	Protect
Document59.	How	do	you	create	a	macro	in	Microsoft	Word?A)	View	>	Macros	>	Record	MacroB)	Insert	>	Macros	>	Record	MacroC)	Home	>	Macros	>	Record	MacroD)	Review	>	Macros	>	Record	MacroAnswer:	A)	View	>	Macros	>	Record	Macro60.	What	is	the	use	of	the	Equation	feature	in	Microsoft	Word?A)	To	insert	mathematical	equationsB)
To	create	tablesC)	To	format	textD)	To	check	spellingAnswer:	A)	To	insert	mathematical	equations61.	How	do	you	create	a	bibliography	in	Microsoft	Word?A)	References	>	BibliographyB)	Insert	>	BibliographyC)	Home	>	BibliographyD)	Review	>	BibliographyAnswer:	A)	References	>	Bibliography62.	What	is	the	purpose	of	the	Navigation	Pane	in
Microsoft	Word?A)	To	easily	navigate	through	the	document	by	headings,	pages,	or	search	resultsB)	To	check	spellingC)	To	insert	imagesD)	To	apply	stylesAnswer:	A)	To	easily	navigate	through	the	document	by	headings,	pages,	or	search	results63.	How	can	you	split	a	window	in	Microsoft	Word?A)	View	>	SplitB)	Insert	>	SplitC)	Home	>	SplitD)
Review	>	SplitAnswer:	A)	View	>	SplitRelated	Article	:	Famous	Computer	Scientists.64.	How	do	you	create	an	index	in	Microsoft	Word?A)	References	>	Index	>	Insert	IndexB)	Insert	>	Index	>	Insert	IndexC)	Home	>	Index	>	Insert	IndexD)	Review	>	Index	>	Insert	IndexAnswer:	A)	References	>	Index	>	Insert	Index65.	What	is	the	function	of	Ctrl	+
K	in	Microsoft	Word?A)	Insert	a	hyperlinkB)	Open	a	new	documentC)	Print	the	documentD)	Save	the	documentAnswer:	A)	Insert	a	hyperlink66.	How	can	you	convert	a	table	to	text	in	Microsoft	Word?A)	Select	table	>	Layout	>	Convert	to	TextB)	Select	table	>	Insert	>	Convert	to	TextC)	Select	table	>	Home	>	Convert	to	TextD)	Select	table	>	View	>
Convert	to	TextAnswer:	A)	Select	table	>	Layout	>	Convert	to	Text67.	What	is	the	function	of	Ctrl	+	Shift	+	K	in	Microsoft	Word?A)	Small	capsB)	Capitalize	textC)	Save	the	documentD)	Close	the	documentAnswer:	A)	Small	caps68.	How	do	you	insert	an	endnote	in	Microsoft	Word?A)	References	>	Insert	EndnoteB)	Insert	>	EndnoteC)	Home	>
EndnoteD)	View	>	EndnoteAnswer:	A)	References	>	Insert	Endnote69.	What	does	Ctrl	+	Alt	+	S	do	in	Microsoft	Word?A)	Split	the	windowB)	Save	the	documentC)	Open	a	new	documentD)	Print	the	documentAnswer:	A)	Split	the	window70.	How	can	you	insert	a	SmartArt	graphic	in	Microsoft	Word?A)	Insert	>	SmartArtB)	Home	>	SmartArtC)	View	>
SmartArtD)	Review	>	SmartArtAnswer:	A)	Insert	>	SmartArt71.	What	is	the	function	of	Ctrl	+	1	in	Microsoft	Word?A)	Single-line	spacingB)	Double-line	spacingC)	Save	the	documentD)	Open	the	documentAnswer:	A)	Single-line	spacing72.	How	do	you	create	a	hyperlink	to	a	bookmark	in	Microsoft	Word?A)	Insert	>	Link	>	BookmarkB)	Home	>	Link	>
BookmarkC)	View	>	Link	>	BookmarkD)	Review	>	Link	>	BookmarkAnswer:	A)	Insert	>	Link	>	Bookmark73.	What	does	Ctrl	+	Shift	+	Spacebar	do	in	Microsoft	Word?A)	Inserts	a	non-breaking	spaceB)	Inserts	a	page	breakC)	Inserts	a	column	breakD)	Inserts	a	line	breakAnswer:	A)	Inserts	a	non-breaking	space74.	How	do	you	create	a	watermark	in
Microsoft	Word?A)	Design	>	WatermarkB)	Insert	>	WatermarkC)	Home	>	WatermarkD)	Review	>	WatermarkAnswer:	A)	Design	>	Watermark75.	What	is	the	function	of	Ctrl	+	Shift	+	N	in	Microsoft	Word?A)	Apply	the	Normal	styleB)	Open	a	new	documentC)	Print	the	documentD)	Save	the	documentAnswer:	A)	Apply	the	Normal	style76.	How	do	you
insert	a	text	box	in	Microsoft	Word?A)	Insert	>	Text	BoxB)	Home	>	Text	BoxC)	View	>	Text	BoxD)	Review	>	Text	BoxAnswer:	A)	Insert	>	Text	Box77.	What	is	the	function	of	Ctrl	+	Shift	+	A	in	Microsoft	Word?A)	Change	text	to	all	capsB)	Select	all	textC)	Save	the	documentD)	Open	the	documentAnswer:	A)	Change	text	to	all	caps78.	How	do	you
insert	a	caption	for	a	picture	in	Microsoft	Word?A)	References	>	Insert	CaptionB)	Insert	>	CaptionC)	Home	>	CaptionD)	Review	>	CaptionAnswer:	A)	References	>	Insert	Caption79.	What	does	Ctrl	+	Shift	+	C	do	in	Microsoft	Word?A)	Copy	formattingB)	Copy	textC)	Paste	textD)	Cut	textAnswer:	A)	Copy	formatting80.	How	do	you	paste	copied
formatting	in	Microsoft	Word?A)	Ctrl	+	Shift	+	VB)	Ctrl	+	Alt	+	VC)	Ctrl	+	VD)	Ctrl	+	Shift	+	CAnswer:	A)	Ctrl	+	Shift	+	V81.	How	can	you	insert	a	bookmark	in	Microsoft	Word?A)	Insert	>	BookmarkB)	Home	>	BookmarkC)	View	>	BookmarkD)	Review	>	BookmarkAnswer:	A)	Insert	>	Bookmark82.	What	is	the	use	of	Ctrl	+	Shift	+	P	in	Microsoft
Word?A)	Change	the	font	sizeB)	Open	the	Print	dialog	boxC)	Open	the	Save	As	dialog	boxD)	Paste	the	textAnswer:	A)	Change	the	font	size83.	How	do	you	insert	a	citation	in	Microsoft	Word?A)	References	>	Insert	CitationB)	Insert	>	CitationC)	Home	>	CitationD)	Review	>	CitationAnswer:	A)	References	>	Insert	Citation84.	How	do	you	change	the
case	of	selected	text	in	Microsoft	Word?A)	Home	>	Change	CaseB)	Insert	>	Change	CaseC)	View	>	Change	CaseD)	Review	>	Change	CaseAnswer:	A)	Home	>	Change	Case85.	What	does	Ctrl	+	Shift	+	E	do	in	Microsoft	Word?A)	Turn	on/off	track	changesB)	Open	the	Edit	dialog	boxC)	Open	the	Save	As	dialog	boxD)	Print	the	documentAnswer:	A)
Turn	on/off	track	changes86.	How	do	you	insert	a	table	of	contents	in	Microsoft	Word?A)	References	>	Table	of	ContentsB)	Insert	>	Table	of	ContentsC)	Home	>	Table	of	ContentsD)	Review	>	Table	of	ContentsAnswer:	A)	References	>	Table	of	Contents87.	What	is	the	function	of	Ctrl	+	L	in	Microsoft	Word?A)	Align	text	leftB)	Align	text	rightC)
Center	textD)	Justify	textAnswer:	A)	Align	text	left88.	How	do	you	insert	a	section	break	in	Microsoft	Word?A)	Page	Layout	>	Breaks	>	Section	BreakB)	Insert	>	Break	>	Section	BreakC)	Home	>	Break	>	Section	BreakD)	Review	>	Break	>	Section	BreakAnswer:	A)	Page	Layout	>	Breaks	>	Section	Break89.	How	do	you	open	the	Find	and	Replace
dialog	box	in	Microsoft	Word?A)	Ctrl	+	HB)	Ctrl	+	FC)	Ctrl	+	GD)	Ctrl	+	NAnswer:	A)	Ctrl	+	H90.	What	is	the	function	of	Ctrl	+	2	in	Microsoft	Word?A)	Double-line	spacingB)	Single-line	spacingC)	Save	the	documentD)	Print	the	documentAnswer:	A)	Double-line	spacing91.	How	do	you	add	a	drop-down	list	in	Microsoft	Word?A)	Developer	>	Drop-
Down	List	Content	ControlB)	Insert	>	Drop-Down	List	Content	ControlC)	Home	>	Drop-Down	List	Content	ControlD)	Review	>	Drop-Down	List	Content	ControlAnswer:	A)	Developer	>	Drop-Down	List	Content	Control92.	How	do	you	split	a	cell	in	a	table	in	Microsoft	Word?A)	Select	cell	>	Layout	>	Split	CellsB)	Select	cell	>	Insert	>	Split	CellsC)
Select	cell	>	Home	>	Split	CellsD)	Select	cell	>	View	>	Split	CellsAnswer:	A)	Select	cell	>	Layout	>	Split	Cells93.	How	can	you	insert	an	auto	text	entry	in	Microsoft	Word?A)	Insert	>	Quick	Parts	>	AutoTextB)	Home	>	AutoTextC)	View	>	AutoTextD)	Review	>	AutoTextAnswer:	A)	Insert	>	Quick	Parts	>	AutoTextRelated	Article	:	Desktop	Support
Engineer	Interview	Questions94.	How	do	you	insert	a	table	of	figures	in	Microsoft	Word?A)	References	>	Insert	Table	of	FiguresB)	Insert	>	Table	of	FiguresC)	Home	>	Table	of	FiguresD)	Review	>	Table	of	FiguresAnswer:	A)	References	>	Insert	Table	of	Figures95.	What	does	Ctrl	+	Shift	+	F5	do	in	Microsoft	Word?A)	Set	or	go	to	a	bookmarkB)	Save
the	documentC)	Print	the	documentD)	Open	the	documentAnswer:	A)	Set	or	go	to	a	bookmark96.	How	do	you	open	the	Paragraph	dialog	box	in	Microsoft	Word?A)	Ctrl	+	Alt	+	MB)	Ctrl	+	Alt	+	PC)	Ctrl	+	Alt	+	LD)	Ctrl	+	Alt	+	CAnswer:	B)	Ctrl	+	Alt	+	P97.	How	do	you	create	a	custom	watermark	in	Microsoft	Word?A)	Design	>	Watermark	>	Custom
WatermarkB)	Insert	>	Watermark	>	Custom	WatermarkC)	Home	>	Watermark	>	Custom	WatermarkD)	Review	>	Watermark	>	Custom	WatermarkAnswer:	A)	Design	>	Watermark	>	Custom	Watermark98.	How	do	you	insert	a	horizontal	line	in	Microsoft	Word?A)	Insert	>	Shapes	>	LineB)	Insert	>	Horizontal	LineC)	Home	>	Horizontal	LineD)	View	>
Horizontal	LineAnswer:	B)	Insert	>	Horizontal	Line99.	How	do	you	open	the	Font	dialog	box	in	Microsoft	Word?A)	Ctrl	+	DB)	Ctrl	+	FC)	Ctrl	+	GD)	Ctrl	+	BAnswer:	A)	Ctrl	+	D100.	What	is	the	function	of	Ctrl	+	T	in	Microsoft	Word?A)	Create	a	hanging	indentB)	Save	the	documentC)	Open	a	new	documentD)	Print	the	documentAnswer:	A)	Create	a
hanging	indentMicrosoft	Word	is	a	powerful	tool	for	creating	and	editing	documents.	By	understanding	ms	word	questions	and	answers,	you	can	make	the	most	of	Words	features	and	enhance	your	productivity.	Whether	youre	a	beginner	or	an	experienced	user,	mastering	these	basics	will	help	you	create	professional-looking	documents	with
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